Andmebaasi moiste

ja kasutusvaldkonnad

Kdige lihtsam viis on andmeid hoida mingite sailitusuhikute kaupa: raamatukogus

raamatute ja riiulite kaupa, arvutis failide ja kaustade kaupa.

Klassikalise definitsiooni jargi on andmebaas korrastatud ja loogiliselt seostatud

andmete hulk, mida sailitatakse andmekandjal minimaalse liiasusega ning mida vdivad

Uksteisest soéltumatult kasutada mitu rakendusprogrammi. Termin "andmebaas" (data

base, Datenbank) ilmus kaibesse 20. sajandi 60.aastate keskel, kui arvutis hakati

programsete vahenditega arendama andmete integreeritud kasutust.

Andmebaasid on naiteks:

raamatukogu kartoteek,

telefoniraamat,

klassipaevik,

teie isiklik telefonimarkmik,

rahvastikuregister,
ARK register,

piirivalve andmebaas,

jne.

Luhidalt:

Andmebaas on kogum andmetest, mida mingil péhjusel on vaja séilitada.

Andmebaas:

realiseerib andmemudeli

vbimaldab (ihiskasutust

minimeerib andmete lilasuse

eristab andmete fuusilise séilitamise andmekandjal nende
kasutamisest,

vbimaldab andmete muutmist ilma slsteemi teisi

komponente muutmata.
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Tabelitootluse ja andmebaaside vordlus

Elektrooniline andmebaas vaib olla...
lameandmebaas:
Lameda andmebaasi moistet kasutatakse monikord Uhe-tabeli-siisteemi puhul (naiteks
Exceli tddleht vdi selle osa). Sel juhul polegi andmemudelit vaja, sest tegemist on vaid the
olemiga (seoseid ei saa kajastada). Kdige parem on lamedat andmebaasi ette kujutada
andmetabelina (millele fudsiliselt voib vastata fail). Tabeli ridu nimetatakse kirjeteks ja
tabeli veerge valjadeks, mis kirjeldatakse tavaliselt (tabeli paises) jargmiste komponentide
abil:
+ nimi;
« tllp (nait. integer, real, character, array, date, picture);
+ kitsendused (nait. minimaal- ja maksimaalvaartus, vaartusvaru, maksimaalne
sumbolite arv jne.).
Selliseks andmebaasiks vdib olla naiteks elektrooniline telefoniraamat.
relatsioonandmebaas:
Relatsiooniline andmebaas koosneb tabelitest ehk relatsioonidest. Erinevalt lamedast
andmebaasist sisaldab ta mitut seostatud tabelit. Kasutaja tasandil hakkame me MS

Accessis tegutsema just selle andmemudeliga.

Relatsioonilise andmebaasi loomine

ja kasutamine MS Access-i vahenditega

Uldine iilesehitus:

Microsoft Access vdimaldab andmeid kirjeldada nende sisulist kokkukuuluvust
arvestades. Andmetabeleid on vdimalik omavahel siduda ja kasutada andmeid paljudest
tabelitest korraga. Tabelite sidumine vbimaldab andmete paremat sailitamist ja
paindlikumat toimetamist, realiseerides seega andmebaasidele omaseid funktsioone.

Andmebaasi avamine ja salvestamine:

Uue andmebaasi loomiseks valige peale MS Access'i avamist algdialoogis (paremal
pool aknas) Blank Database vdi menlust File>New Database. Sisestage andmebaasile
nimi ja salvestage soovitavas kaustas.

Olemasoleva andmebaasi avamiseks valige algdialoogis Open an Existing Database

vOi menuust File> Open Database...
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Andmebaasi aken:

. Qpen [ef Design g Mew Bp "o femec|EE
Objects @ Create table in Design view

B  Tables @ Create bable by using wizard

e @ Create table by entering data

Forms
Reports
Pages

Macros

@ Nl E G

Modules

Groups

[#] Favorites

Accessi andmebaas on konteinerfail (laiendiga *.mdb), mis vdib sisaldada jargmist
tuUpi objekte:
tabelid (tables) on andmebaasi pdhikomponendiks; ta peab sisaldama primaarvétit -
see on vali tabelis, mille sisu on iga kirje jaoks erinev; tabelite vahel on véimalik
defineerida seoseid,
paringud (queries) on pohivahend vajaliku info kattesaamiseks Uhest vdi mitmest
seotud tabelist,
(ekraani)vormid (forms) on graafilised elemendid andmete sisestamiseks ja
muutmiseks; ekraanvorme on otstarbekas kasutada kui andmeid tuleb sisestada,
muuta vdi sageli vaadata.
(trtki)aruanded (reports) esitavad andmebaasi andmeid Ulevaatlikul kujul paberil;
pdhieesmargiks on teha vahe- ja |6ppkokkuvdtteid, lisada tekste, jaotada tekst
lehekulgedeks, nummerdada lehekulgi.
Neid saab valida andmebaasiakna lipikute abil. Hiireklops lipikul avab vastavat tiupi
objektide loetelu, millest tuleb topeltkldpsuga valida vajalik tabel, vorm jne.
Korraga saab todtada ainult Ghe andmebaasiga, konteinerfaili fGUsilisele struktuurile
kasutaja ligi ei paase (naiteks ei saa kasutada korraldust Save as...). Andmebaasi suurust

piirab praktiliselt ainult kdvaketta maht.
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Andmebaasi loomine:

Esimene asjana, kui Uldse andmebaasi tegema hakata, tuleb meil selgeks teha,
millist infot peaks loodav andmebaas endas sisaldama. Andmebaasist pole kasu, kui sealt
vajalikku infot katte ei saa. Andmebaas peab rahuldama nii hetke- kui tulevikuvajadusi.
Seetdttu tuleb taotleda seda, et vajalike objektide kohta sisestataks piisavalt pohjalik info,
kuid valditaks Uleliigse info sisestamist.

Kdige esmalt tuleb paberile kirja panna, milliste objektide kohta infot vajatakse ja
milliseid andmeid on iga objekti kohta vaja. Kui tabeli koostamiseks ei kavatseta kasutada
tabelitarka, siis tuleb eelnevalt maarata ka iga valja tuup ja pikkus. Iga valja kohta tuleb
otsustada, kas see sisaldab ainult numbreid (Number) véi mitmesuguseid marke, viimsel
juhul on tegemist tekstivaljaga (Text).

Andmetiiiibid, nende omadused:

Igal tabeli andmevaljal (veerul) on kindlad omadused, mida iseloomustavad:

valjanimi - vdivad koosneda mitmest sdnast, sisaldada eesti tappidega tahti; pikkus

kuni 64 simbolit,

valja tuup:
Tiiiip Sisu Pikkus
Tekst Sumbolid kuni 255 baiti
Memo Sumbolid Kuni 32000 baiti
Number Tais- vdi murdarvud 1,2,4 voi 8 baiti
Kuupaev/aeg Kuupéevad ja kellaajad 8 baiti
Raha Rahasummad 8 baiti
Loendaja Kirjete jarjekorranumbrid 4 baiti
Jah/Ei Loogilised vaartused 1 bitt
OLE objekt Graafikud, pildid, helid vdi  Kuni 1GB

muud binaarfailid

valja kirjeldus - kirjeldus kuni 64 simbolit (valjastatakse teadetereale — naiteks juhis
valja taitmiseks),

védlja omadus:

Omadus ’ Mida mdidirab
Field size Teksti- voi numbrivalja pikkuse
Format Kuidas andmeid kuvatakse
Decimal Places Kumnendkohtade arvu parast koma
Input Mask Kuidas andmeid tuleb sisestada
Caption Valja nimetus, mida kasutatakse vormidel ja aruannetel
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Omadus Mida mddrab

Default value Vaikevaartus

Validation Rule Kontrollimiseeskiri andmete sisestamisel
Validation Text Veateade sisestusvea korral

Required Kas vali peab olema taidetud

Allow Zero Lenght Kas nullpikkusega stringid on lubatud
Indexed Kas valja sisu kasutatakse indeksina

Numbrite vormingud:
standard (kaks kimnendkohta)
currency (lisatakse rahaulhik)
fixed (Umardatakse lahima taisarvuni)
percent (korrutatakse sajaga)
scientific (esitatakse poollogaritmilisel kujul)
Numbrite pikkused:
byte (arvud 0-255)
single (£3,4*1038)
double (£1797*10308)
integer (£32768)
long integer (£2147483648)
Kimnendkohti véib olla single puhul 7, double puhul 15.
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Tabeli loomine

Uut andmebaasi on kodige lihtsam luua andmebaasitarga abil. Kui olete avanud MS
Access'i ja valinud uue andmebaasi (Blank Database) ja selle salvestanud, siis avaneb

teile uus aken, mis kannab nime: teie poolt antud pealkiri: Database.

= andmebaas1 : Database (Access 2000 file format) EH_”EJ

[ open [&f Design 5 Mew i e
| Objects Create table in Design view
Tables Create table by using wizard
B Cueries Create table by entering data
Forms
= Reports
Groups

Antud aknas saab valida objekti tuupi, millega tahate antud andmebaasi teha.
Vaatleme esmalt tabeleid. Tabeli veerge nimetatakse valjadeks (Field), ridu aga kirjeteks
(Record). Igal valjal asuvad kindlat tadpi andmed. Andmetlupidest on juba eespool juttu
olnud. Kirje on Uhe objekti andmete kogum.

Esiteks aga tuleb paika panna, mille kohta andmebaas Uldse luua. Proovime teha
naiteks tabelid klassitunni ja asukoha kohta ning hiljem vaatame, kuidas on véimalik neid
kahte tabelit omavahel siduda.

Tabelite loomiseks on mitu véimalust.

Koostanud: Merike Hein



Esimesel juhul:
Soovitatav on kasutada tabeli loomist kujundusvaates (Design View). Selleks valige

andmebaasi aknas Tables ja topelt hiireklops valikul Create table in Design View.

Avanevas aknas

& Table1 : Table =13
.

Field Mame Data Tvpe Description

2

Field Properties

General l Lookup ]

4 Field name
can be up ko
&4 characters
lona, including
Spaces.
Press F1 Far
help on field
names.

tuleb maarata:
valjade nimed (Field Name) — ei vdi sisaldada punkti,
andmetuibid (Data Type) — vali lahtrisse sisenemisel avanevast rippmenuust,
voib lisada ka valja kirjelduse (Description), mis ilmub tabelivaates ekraani allservas
olevale inforeale.

Taidame klassitunni tabeli selliste andmetega:

Field Name Data Type Description
Nimi Text Tunni nimetus
Nime ID Text Tunni lithend
Esitaja Text Tunni ldbiviija
Kestvus Text Tunni ldbiviimisaeg
Ruum Text Tunni asukoht

Peale andmete sisestamist, tuleb maarata primaarvoti ehk tunnusmark, mis iga kirje
jaoks on erinev. Access ei luba sisestada tabelisse kirjet, mille primaarvéti langeb kokku
juba tabelis oleva kirjega. Antud tabelis vdiks selleks olla Nime_ID. Seega, et teha tunni
[Uhendit primaarvétmeks, tuleb minna antud tabelis Nime ID peale ja valida parema

hiireklahviga Primary Key. Siiani naeb tabel valja selline (ilma primaarvétmeta):
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Ed Tablel : Tahle

Diescription .

Field Mame Daka Twvpe
Flirmi Texk Tunni nimekus
rirme_ID Texk Tunni lUhend
Esitaja Texk Tunni labiviija
Keskwus Texk Tunni |&biviimisasg
Ruuam Texk Tunni asukohk G

Genaral ] Lookup ]

Field Properties

Laheme antud akna alumise poole juurde. Selleks valite Glemises pooles vajaliku

valja nime ja vajutate klahvi F6. Kursor siirdub alumisse aknapoolde, kus on kuvatud

valitud valja omadused. Selles pooles saab iga sisestatud valja sisu struktuuri muuta.

Valjade omadustest on juttu olnud juba eelmistel lehekulgedel, kuid antud juhul voiks

teha sellise muudatuse — valida sobiliku kestvust. Selleks lahete Ulemises aknapooles

valjale Kestvus ja liigute eespool kirjeldatult alumisse aknapoolde. Et kuju maarata, tuleb

valida Input Mask rida. Lahete antud rea I16pus olevale kolmele punktile ja klikkide sellel.

Selle tulemusena soovitakse teada, kas tahate tabelit salvestada ja te valite Yes.

Salvestage nimega TUND.
Peale seda avaneb teile

selline aken:

To see how a selected mask works, use the Try Ik box,

To change the Inpuk Mask lisk, click the Edit Lisk bukkan,

Input Mask:

‘Phone Mumber
Social Security Mumber
Zip Code

Extension

Passwiord

Long Time

Data Look:

Input Mask Wizard

Which inpuk rmask matches how wau want daka ko look?

95052-6399
B3215

bkt s St

1:1z:00 PM M

Try IE: ]

Edit List | Cancel

| Mexk = | Finish
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Antud loetelust valite Short Time ja valite Next. Jargmises osas voite jatta numbri

kuju samaks ja Finish.

Nuud vdiks asuda tabelit taitma andmetega. Selleks valite aknamenuuribalt View =>

avaneb teile aken:

E TUHMD : Tahle

Datasheet View. Teie kaest kisitakse uuesti, kas tahate salvestada. Peale Yes vastamist

| Record: Hl 4 ” 1. F lH IHIEI of 1

Antud aknasse tuleb kanda puuduvad andmed. Taitke tuhjad lahtrid selliste

andmetega:
Nimi Nime_ID Esitaja Kestvus Ruum
Eesti keel EK A. Kuusk 00:45 24
Inglise keel IK K. Rahk 00:45 75
Saksa keel SK T. Muru 01:45 73
Matemaatika Mat E. Puu 02:00 23
Arvutidpetus A M. Klement 01:45 78
Flusika F M. Jogi 01:45 35
Keemia K K. Partel 00:45 41
Bioloogia Bio S. Visnapuu 00:45 62

Ja ongi esimene tabel koos andmetega valmis. Salvestage.
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Teisel juhul:
Enne kui laheme tabelite sidumise kallale, vaatame teist vOimalust teha tabel

andmebaasitarga abil, seega valite Create table by using wizard. Sellel klikkides, avaneb

selline aken: Tahle Wizard

Wehich of the sample tables listed below do wou wank to use to create wour table?
After selecting a table category, choose the sample table and sample Fields vou want o include
in your new table, Your kable can include fields From more than one sample table, IF you're not
sure about a field, go ahead and include it It's easy to delete a field later,
Sample Figlds: Figlds in my new kable:
o Maiinglistio [P
= Prefix =
Sample Tables: FirstMame e
Middletame
LastMame
Contacts SFFise
_usktamers Mickname
Emplovess Tithe J
Products OrganizationMame
Orders B Addrazs
Cancel | |

Nuld teeme teise tabeli, mis vdiks kanda pealkirja Koht. Valime Table Wizard'i
aknas Personal tuupi tabeli. Sample Fields lahtrist paigutame margi ,, > “ abil Fields in my
new table lahtrisse need valjad, mis peaksid kajastuma meie uues tabelis. Need voiksid
siis olla: AddressID, Address ja Notes. Kuna valjade nimed on kirjutatud hetkel inglise
keeles, siis nupu Rename Field... on vdimalik muuta meie tabeli jaoks valitud valjad

eestikeelseteks. Table Wizard

hich of the sample kables listed below do wou wank to use ko create wour table?

After selecting a kable cateqory, choose the sample table and sample Fields vou wank ko include
in your new table, Your table can include Fields From more than one sample table. IF vou're not
sure about a field, go ahead and include it. It's easy to delete a field laker,

™ Business Sample Fields: Fields in my new table:
& Personal FirstMame # = koha_ID
LastMame kohtade ary
Sample Tables: Spousehlame s Aadress
Childrentames
Address
Guesks =
Categories StakeorProvince e
Household Inventary FostalCode
Recipes CounkryReqgion
Plants M Frnailaddrecz et

Zancel
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Table Wizard

fiddresses

wehat do wou want ko name your table?

[

W e G Pl

WHIE HHE RN
WHIE HHE RN
WHIE HHE RN
WHIE HHE RN
WHIE HHE RN

Microsoft Access uses a special kind of field, called a primary key,
ko uniquely idenkify each record in a table. In the same way a
license plake number identifies a car, a primary key identifies a

recard,

Do vou wank the wizard bo set a primary key For wou?

(¥ Yes, set a primary key For me,

. Mo, T'll sek the primary key.

Cancel

< Back.

[exk =

Finish

Edasi - jargmises osas tuleb panna pealkiri uuele tabelile. Olgu selleks siis KOHT.

Veel soovitakse teada, kas soovite, et tabelitark maaraks teie eest primaarvotme voi

soovite seda ise teha. Valime jalle isetegemise — No, I'll set the primary key.

Table Wizard

3

4
5

| RETER
AT ]

T e o Y
T4 nunouun unn

23
32
13

=

A nnn unn
B3 nun ounn
G2 uan une

D5 sun wan

El

What type of data do wou want the primary key figld bo contain?

¥ Consecutive numbers Microsoft Access assigns aukomatically
ko new records,

What field will hold data that is unique for each recard?
lkoha_ic|

" Mumbers I enter when I add new records,

O Numbers andfor letkers I enter when I add new records,

Cancel

< Back

Mext =

Einish

Edasi — soovitakse teada, millise valja andmed on unikaalsed. Olgu selleks Koha_ID.

Siis soovitakse teada, mis tudpi andmeid me tahame, et primarvétme vali sisaldaks.

Jaame kolmanda valiku juurde.
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Table Wizard

I= wour new table related to any other tables in your database? Related tables have matching
records. Usually, wour new table is related to at least one ather table in the current dakabase.

In some cases, the wizard will create table relationships for vou, The lisk below shows how your
new kable is related to existing tables, To change how a table is related, select a kable in the
list and click Relationships.

My new 'KOHT table is L.

HER HHR HRE RER
HHH HHH HHH HHH
HHER HER HRE RER
HHH HHE CHEE NER
HHH HHH HHH HHH

Relationships. ..

Cancel % Back, Mexk = Einish

Edasi — jargnevalt antakse teada, kas tehtud tabel KOHT on seotud varem tehtud
tabeliga TUND. Jatame praegu nad mitte seotuks. Seega valime Finish. Nuud saame
hakata taitma tabelit KOHT selliste andmetega. Peale taitmist salvestage.

Koha_ID Kohtade arv Aadress
LK_2 100 Kruusa 6
LK 3 45 Kastani 34
TM_6 50 Marja 12
MM_8 80 Tina 4

Koostanud: Merike Hein



Tabelite seostamine

Relatsioonilise andmebaasi "selgrooks" on tabelite seostamine, sest kasitletav
valdkond on tavaliselt kirjeldatud paljude tabelitega. Accessis saab seoseid interaktiivselt
luua ja graafiliselt naha. Seose tulpi saab maarata otse ja kaudselt. Proovime nlud
tehtud kahte tabelit omavahel siduda. Selleks valime MS Accessi aknas Tools =>
Relationships. Selle tulemusena kuvatakse kaks aknet, kus Relationships aknasse tulevad
vormingud ja Show Table aknas vdetakse loetelust need tabelid, mida tahetakse siduda.
Hetke seisuga on seal kaks tabeli — KOHT ja TUND - lisame need (Add). Suleme Show
Table akna. Seega jaab aken Relationships, mis on selline:

=2 Relationships EIE'E'

Koha_ID
Kohtade arv

Hadress

Kuna alguses KOHT tabeli loomisel me ei sidunud teda tabeli TUNNIGA, siis tuleb
votta MS Access'i menuust Relationships => Edit Relationships, mille tulemusena avaneb

taoline aken: Edit Relationships
TablefQuery: Felated Table/Query:
| _J _] Cancel
=] ~
w
L A ML e _ Create hlew, .
P
r
Relationship Type:
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Klikkime Create New... .

Uues aknas paigutame vasakpoolsesse lahtrisse KOHT ja

parempoolsesse TUND. Alumised lahtrid taidame vastavalt selle, kuidas need kaks tabelit
seotud on. Antud juhul vdiksid nad seotud olla Koha_ID ja Ruumiga. Seega peale nende

valikute maaramist OK. Aken Edit Relationships muutub selliseks:

?]X]

Edit Relationships

Table/Cuery:

Related Table/Query:

]._,..

Koha_ID

__'_1 Fuum

<

Join Type..

_reake

Cancel

[ Enforce Referential Inteqgrity
[T Cascade Update |
[T Cascade Delete Relat

|
e ]
Helabted Field

= 1 R
e [ | et B %

Relationship Tvpe: Cne-Ta-Many

Creakte Mew,,

Peale Create nupu vajutamist saame Relationships tabeli kuju selliselt (kaks tabelit on

| £

seotud):
= = Relationships
kohtade ary
Aadress
Salvestage.
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